Office to Flash Converter Pro
Create Amazing Page-flipping eBooks with DOCs

User Documentation

Note: This product is distributed on a ‘try-before-you-buy’ basis. All features described in this
documentation are enabled. The unregistered version will be added a demo watermark.

About Office to Flash Converter Pro

If you want to show your PDF, microsoft Office Documents (.docx;.pptx;.rtf;.txt) and OpenOffice
(*.odt;*.odp;*.0ds;*.0odg;*.0db) in a fresh and popular way, converting Office to Page-flipping
eBooks could be a good choice.

Flip books, no longer simple illustrated books for children, but also refer to the e-books which
combine page-flipping effect with electronic technology. This brand new publishing mode is
changing the way how the 'common' people will receive and view information. Normally by just
clicking the page on your computer screen, then you can flip and read the pages as reading real
ones. It looks really innovative and you can use it for your presentation.

And program Office to Flash Converter Pro is powerful enough to convert your DOCs to such kind
of eBooks with ease.

Office to Flash Converter Pro is flexible software to convert PDF, Office Documents
(.docx;.pptx;.rtf;.txt) and OpenOffice (*.odt;*.odp;*.ods;*.odg;*.odb) to stunning page-flipping
eBooks. The program can be used for all levels of users without any programming knowledge
needed. It will perfectly integrate your Office pages with life-like page turning effect into a new
look eBook to be published, emailed, stored as standalone EXE format or even with burned to CD.

With using Office to Flash Converter Pro, you can build your style eBooks using the dozens of
preset templates and adjust more than 50 kinds of settings yourself. You are able to use your
favorite background images, sounds, titles, exe logos, you can control book size, font, font and tool
bar buttons, you can even choose a hard or soft cover, right to left flipping and auto flipping to
present your DOCs in an interactive way.

After designing style for your page-flipping eBooks, you can choose a proper way to output:
"HTML" is for publishing online, "ZIP" can be much easier for emailing, "EXE" is an intergraded
format for quickly viewing, "Burn to CD" to output your digital books directly on CD-ROM.
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Detail features:

® Convert PDF and Office Documents (.docx;.pptx;.rtf;.txt) to page-flipping eBooks.
® Convert OpenOffice (*.odt;*.odp;*.ods;*.odg;*.odb) to page-flipping eBooks.
® Output in 4 different formats: HTML, EXE, Zip and Burn to CD.
HTML allows you to upload to a website to be viewed online.
EXE and Zip allow you to send to your user by email to be viewed on their computer.
Burn to CD allows you to burn to disk so you can send out with physical media.
® Make a Mobile Version at the same time.
® Define your language for flash.
® Preview the output effect instantly.
® Provide multiple templates (default provided or download from website).
® Select render engine to output higher quality page-flipping ebook.
® Define mobile version quality.
® Import bookmarks (outline) with Office, and edit them manually.
® Import text so that text is searchable, define the minimum search characters.
® Set eBook size, choose landscape or portrait.
® Add password to protect your page-flipping eBook.
® Define titles, keywords and other metadata.
® Add Google Analytics Support.
® Define titles, icon, window size for EXE page-flipping eBooks.
® Define eBook margin size.
® Insert background music either for continuous play (loop) or for a set duration.
® Set background color and image.
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® Set eBook reading from right to left (for Right-to-Left languages such as Arabic).
® Choose hard cover for eBooks.

® Set page-flipping to manual or automatic.

® Set permissions for downloading, printing, sharing, Home button and more.

® Set colors and position (Top/Bottom) for toolbar.

® Set scale for zoom-in function.

® Set control bars to "show" or "hide" in full screen.

® Set the bookmark panel to show on left or right side.

® Set links to open in same or new window.

® Save and Load your project.

® Export and save settings for future use.

Using Office to Flash Converter Pro
Office to Flash Converter Pro can be started either by launching the application via the desktop short

cut, or directly from Windows Explorer. Start the program, you will see the below initial window:
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[\l F:p Office Professional Unzegissered — Flip Office Professional Overvie [P

|

Y Design Setting | Baokmark |

Templates FLIPBUILDER.COM  pgges: 1/10

L B [ ES®

Please customize the flash template here

File Conwert Optiens Help

@ Import Office G Apply Change

Edit Pages ‘ % Convert To Flipping Book @g Batch Convert

ElTool Bar Settings
EITitle Bar
The Book Logo
Logo URL
Book Title FLIPBUILDER....
Page Mumber Box On ... False
ElButtons Bar

[ »

EHome Button
Home Button Visible  |Hide
Page URL wiFLPBU DeR ok | IFLIP OFFICE Pro
Open Window Self
& About Button
About Button Visible  |Hide
Content Convert PDF, DOCX, PPTX, RTF, TXT to
Full Screen Button Show S Flash Flip Book With Real Page Turn Effect!

Convert OpenDffice to FlippingBook
Embed Video With Yoar Flip Beok

Q T g g ok o o Hss

E- =

The file in the processing interface is an example file.

There are some main interfaces you will see while using Office to Flash Converter Pro as below shows:
Application Options, Import Office Document, Template Settings, Language Option and Output. You can
enter into each page to get clear instructions for every detail option.

I. Application Options Interface

1. Render Engine Option

Office to Flash Converter Pro provides 3 different render engines for you to create higher quality
page-flipping eBooks, click "Options->Application Options" to enter into "Render Engine" interface:
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@ Cptions |

Render Engine | Create Mobile Version

Pleaze selecte a render engine for the conversion

@ SWF
4

(7 GPL Ghostscript Dowload Ghostscript

() Inner Library

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality

Inner Library: Faster convert speed

SWEF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when Office Doc imported failed)

2. Create Mobile Version Option

Five types of "Quality And Size":

Pages Quality and Size

Quality And Size:

High quality large file size
Medium quality medium file size
Lowe quality small file size
Lower quality smaller file size

High values
LY but require m
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Il. Import Office Interface:

0 Import Office Document =
il e BB—
Source Office Flie (.pdf;.dood;. ppb;. tct; . rif)
Ci\sers\Administrator \Desktopphoto_flipbook_builder. docx [ Browse.. ] [ Cpen it ]
The Page Ranges to Import Watermark
s ,l!"" ~ Place a custom text or image
() Custom range: Example: 1,3,5,9-21 "’j B
Quickly import (Only import 10 pages to initial preview) Set Watermark
Page Quality
Quality And Size: ’High quality large file size "]

M High values produce better page quality but require more disk space and more time to download.

Import bookmark Impaort links []Enable search

gant:e'

Panel Description:

1. Source Office File

o
- Click this icon to open the Office file you want to convert;

Released: February 2012 Page 6 of 29

Copyright © 2012 pdf-to-flash-converter.com - all rights reserved



Office to Flash Converter Pro
Create Amazing Page-flipping eBooks with DOCs

User Documentation

Open it .
View content of added Office file to clarify before converting.

2. The Page Ranges to Import

@ All pages
Convert all pages to page-flipping eBooks;

(@ Custom range: 2-5 Example: 1,3,5,9-21
Convert a range pages to eBook;

[¥] Quickly impart {Only import 10 pages to initial preview) . . .
Preview applied effect on first 10.

3. Watermark

Add image or text watermark to flipping pages.

| Applying Wate k . . .
[¥] Applying Watermar Check this option first to choose default stamps or add new ones:
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Page-flipping eBook

B

Edit /
Add text stamp

Add image stamp.

Delete

Move down

2> ¢ X 8 &

Move up

4. Page Quality

There are five types of "Quality And Size":

High quality Iz

High guality large file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

5. Other Options

[¥] Import bookmark . . . . . . o
If your Office file contains bookmarks, check this option to use in output page-flipping

eBook;

Impartlinks | £\ our Office file has links, check this to enable in flipbook;
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Enable search . . . . .
] Check this option to enable search functionality in created flipbook.

At last, click

icon to enter into template setting interface.

lll. Template Settings Interface:

W) F1ip Office Frofessional Inzegiszered — Flip ﬁffici-Prnfessinmal Overvier

File Convert Options Help

@ Import Office G Apply Change

Edit Pages ‘ % Convert To Flipping Book ‘ @ Batch Convert

[

Y Design Setting | Bookmark |
Templates

[ B [ @&

Please customize the flash template here

FLIPBUTLDER.COM  pgges: 1/10

ElTool Bar Settings
ETitle Bar
The Book Logo
Logo URL
Book Title FLIPBUILDER....

[an] »

Page Mumber Box On ...|False
EButtons Bar

EHome Button

Home Button Visble  |Hide

Page URL ewWFUPBULOER oM [FLIP OFFICE P

Open Window Self

[l About Button

About Button Visible  |Hide

Content Convert PDF, DOCX, PPTX, RTF, TXT to

Full Screen Button Show S Flash Flip Book With Real Page Turn Effect!
Convert OpenOffice to FlippingBook

Embed Video With Your Flin Beok

H oo o = if )

The program provides three different templates at present: Classical, Float and Spread.
Each template contains some unique settings, the below instructions will show you details.

The design setting interface contains below main parts:
Choose Template

Book

Sound

Tool Bar
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Initial Show
Bookmark
Language
Security Settings

Panel Description:

1. Choose Template
Templates

‘ If ciassical ‘H E&

Please customise the flash template here

icon to select templates from below interface:
'macnrm o

Choose 8 fipbook Sempiate here, (Double-chci o mahe » quick sekechon)
e sndd e hesplates wil be proied in Aiture.)

| Tempaies

i A= res T |

| = o I | -

Bk Bhwn Crhardd

Click this icon is to save current settings as a TXT file for later uses;

Click this icon is to import stored setting file at once.
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2. Book Panel

ElBook
Book Title www . FlipB. ..
Hide Book Frame Bar Mo
Retain the book to center (Mo

HEook Propartions
Top Margin 10
Bottom Margin 10
Left Marain a0
Right Margin 60
Flash Window Color M0x021425

Page Background Color | ] 0ucffAFff
EHPage Shadow

HBackground Config
Right To Left Mo
Hard Cover Mo
Flipping Time 0.6

(1) Book Title (only can be set in Float Template)

| BookTitle

Customize book title for showing on the top of your flipbook.

(2) Hide Book Frame Bar
| Hide Book Frame Bar es |

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center

| Retain the book to center [Yes Rd

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for embedding
special background image, such as advertisement or company log.
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(4) Book Proportions

BiBoak Proportons
Page Width 595
Page Haight 842

Width

Please note that the values are not fixed in pixels or inches, they just represent a ratio for "Page Width:
Page Height", and the book size will be changed depend on your Explorer Window Size.

(5) Book Margin

A. Book Margin (set in Classical Template):

"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):
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~) Bottom

(6) Flash Window Color

M ox2Es...| d

[ Flash Window Color |

This color will be applied on all flash windows, such as the book window, "Help" window, "Print" window
and so on.

(7) Page Background Color

When load pages, or if the page number of your Office file is odd, then the page (the last page) will show
with the "Page Background Color".
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_(8) Page Shadow

[ElPage Shadow |
Left page Shadow | 100
Right page Shadow |55
Page Shadow Opadity |1

Left page Shadow
e

| Right page Shadow|
The value also takes the value of Book Proportions as reference, and the value interval of "Page Shadow
Opacity" is "0~1", the larger value refers to the deeper shadow color.

(9) Background Config
A. Background Color:

~Gradient Color A
. 4

Gradient Color B7™ |
Define background for your flipbook with gradient color or pure color (the same color for "Gradient Color
A" and "Gradient Color B"). Gradient Angle is the angle between the two colors.

B. Backgrou_nd Image setting in Classical and Spread templates:
= !ma-.:: PR 2
| Image position Fil

Click the icon "=2I" to choose background image from your computer, and there are 11 kinds of "Image
Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center,
Middle Right, Bottom Left, Bottom Center and Bottom Right.
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C. Background Image setting in Float template:

es you to add two background images: Outer Image and Inner Image. You can make
Inner background image to show special information, such as advertisement or company logo, etc. There
are also 11 kinds of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

(10) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in "Right to Left"

option:
| RightTolLeft Yes

(11) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your flipbook, choose
"Yes" in "Hard Cover" option:

: Hard Cover Yes
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(12) Flipping time
Sets page flipping time in seconds according to your needs. (Recommended second value is 0.6):
Flipping Time 0.6

3. Sound Panel

Hsound
Enable Sound Enable

| Sound File hple3.mp 3 J
Sound Loops -1

If you want to add background sound to your flipbook, such as a song or other audio file, set "Enable
Sound->Enable", then click "] icon to choose "Sound File" from your computer, then set "Sound Loops",
"-1" stands for playing the sound file all the time while viewing flipbook, other value (N>0) stands for the
times of playing the sound file.

4, Tool Bar
E Tool Bar
Icon Color (o
[# Zoom Config
Print Enahle Yes
Search Button Hide

Search Highlight Color W 0x 408080
Least search characters |3
FHDownload setting
Full Screen Button Show
Help Button Show
[ Share Button
FHome Button
[ Auto Flip
Tool Bar on top False
Page Mumber Box On B... |False

(1) Tool bar (only in Classical Template)
Tool bar Shaw Show or Hide Tool bar in created flipbook.

(2) Icon Color

Icon Color [ oxFFrF = |
7 QA = Q
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(3) Zoom Config

ElZaom Config
Zoom in enable Yes

i Gt e s iy

To enable Zoon In functionality, choose 'Yes" in "Zoon in enable", you can set "Zoom Scale" in Classical
Template, the value is the times between zoomed page size and the current page size.

(4) Print Enable
Print Enable fes

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

= Pnnt *

=) Print AN Pages
_J Print Current Page
_ Print Range

Exampie; 2,5,8-26

& Print

(5) Search Button:

Search Button Show

Search Highlight Caolor W ox4058030

Least search characters |3
Select "Show" in "Search Button" (make sure you have check "Enable Search" option in "Import Office"
interface), then define "Search Highlight Color" and "Least search characters", after clicking "Search" icon
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, you will see a popup box to input search words, then click Enter or "Search" button, you will get the
below searching result:

— b

L T T L um—
L —————
P e e e
o s e o ey
= e R e
1 e we e  E—
g e
o e o v s e o
T T T
P — o o gt v
P

- e & e N

(6) Download setting:
BlDownload setting
Download Enable Yes
| Download urL PPTDemo.ppf

If you want your flipbook readers to download the Office file or the flipbook directly from your website,
select "Yes" in "Download Enable" option, then input the Download URL directly, you can use absolute path
like "http://www.flippagemaker.com/FLIPBOOK-Word/example/files/download/FlipWORDDemo.doc" or
relative path like "/files/download/FlipWORDDemo.doc" (make sure you have uploaded the WORD file to
the same path).

Then readers can click the icon E to download your uploaded Office file directly.

(7) Full Screen

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen Button" option:
Full Screen Button | Show

Then you can click icon Eto view flipbook in Full Screen, click icon mor "Esc" button to exit from
the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, you can set "No"
in "Full Screen without Tool Bar" (just in Classical Template): ... Full Screen Without Toal,. Yes

(8) Help Button

To show tips about viewing flipbook, you can set "Show" in "Help Button"
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option: Help Button Show

Then you can see the button and click to get the tips as below:
“ Help b 4

J Double click to Toom in orf out

\f Drag the page corner to wiew

(9) Share Button

If you want your flipbook viewers to send the link to their friends or clients, you can add a share button in
your flipbook for readers to send out your flipbook link immediately:
ElShare Button

Share Button Show
Email Subject Rear my fli...
Email Body fink}

When the viewers click the share buttonE, they will enter into the Email interface with the link of your
flipbook in the Email body.

(10) Home Button

You can add a home buttonm to help reader to click and go to your website directly:
ElHome Button
Home Button Visible Shaow
Page URL http: /flipbuil. ..
Open Window Blank

(11) Auto Flip

EAuto Flip
Enable Yes
Flip Interval 3
Play Count -1

Auto flip when startup |Yes
To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the Flip Interval
(seconds of staying on each page); the value of "Play Count" stands for the times of auto playing the eBook,

and "-1" stands for playing forever (after clicking the Auto Flip button “, the flipbooks will be flipped
by staying 3 seconds per page); if you want to auto start and flip the eBook after opening, just set "Auto flip
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when start up->Yes":

(12) Tool Bar on Top
Tool Bar on top True

(13) Page Number Box on Bottom
Page Mumber Box On B... |True

5. Initial Show (set in Float/ Spread Template)

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just select
"Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails":| - ___ '|

Then you will get flipbook shown with below initial interface:

6. Bookmark
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BB
Font color [

e i | =

Desgn Setang | Back=ark

o xl = + 4
ol e sen e ok bure
Title Fage

{1 | About Flig weoed 2
V| Prodisst feshuet 3
'] Page-licping eBock feahres 5
) Quick Shart (3

. I:Ll Inilaifaees 4
] | Licenge Agieements 1
('] How to Ordes EE
7] Suppcet 1

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be adjusted
automatically based on your defined flash window color), you can set "Font color", "Background color",
"Background alpha" (refers to the background opacity, value interval: 0~1, "0" stands for the background is
totally transparent), "Always Show Bookmark->True/ False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import Office " interface, or you
want to create new bookmarks for your flipbook, you can add bookmarks even sub-bookmarks here, click
"Add" icons and then input "Title" and "Page".

When click the bookmark button, it will popup the bookmark panel immediately, and click on those
bookmarks, it will jump to the defined page automatically.

7. Links

|

If you have check "Import links" option in "Import Office " interface, then you can define settings here,
choose "Mouse over color", "Link alpha" (refers to the link area opacity, value interval: 0~1, "0" stands for
the area is totally transparent), "Border color", "Border width" and "Open Window->Blank/ Self". The links
also can be clicked after zooming by setting "Enable after Zooming in->Enable".
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8. Language

|_Lanquage Endglish |

You can set language for showing tools or tips in your created flipbook, and here is the specialized
instruction page for setting the "Language Option".

9. Security Settings

| Security Settings Single Pass |

If you want to protect your flash books with passwords, you can click "..." icon to enter into "Flash Security
Config" interface:

r@ Flash Secunity Config M

Mote:
Single Password opbion means that users need the password to view the flash book.

Exdude Front Pages oplon is to s2t a page number, alllatter pages can't be
wviewed without inputting password.

Security Type
Ho Security
I 1
g &) Single Password: 123456

Protect Page Range
| o Al Pages

| Exdude Front Pages

Lo ] [ g |

Select "Security Type->Single Password", and input passwords into the box (there is no restriction on
password format at present). You can also set "Protect Page Range" as "All Pages" or the latter pages after
a defined page number. (Tips: The program utilize RC4 algorithm to protect eBook pages, the eBook
content pages will show nothing without permission.)

10. Font
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Product features

Font Color |LIoxFFFF80
Button Font BritannigBold
Window Font Color

Window Font )
Bookmark Font Color
Bookmark Font

License Agreements

How to Dirder

If you want to change fonts of toolbar buttons, flash windows even bookmarks, you can set font types and
colors in Font Panel.

11. Google Analytics

Google Analytics ID

In the HTML output format, you can add statistics by using google analytics. You can get more information
about Google Analytics ID from http://www.google.com/analytics/ .

ﬂ Apply Change

At last, click icon to apply the settings.

IV. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below shows:
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You can new or edit a language for the flash fiipping book.
The Labled column below is the string that will be displayed in the flach,
w The language wil be st in the flash template settings

Language Settings
Label Labled | | [Giea
Frst Button First
Next Page Button Next Page |
Last Button Last
Previous Page Button Previous Page £
Download Button Download
Print Button Print
Search Button Search
Book Mark Button Book Mark l
Heip Button Help [
Enable FulScreen Button Enable FulScreen
Disable FullSoreen Button Disable FullSoesn
| Gt Pie Bt Gl Py T

Panel Description:

As the tips explaining, the "Labled" column lists the buttons and instructions on Flash books in defined
language, and the program provides you five different languages for you to use: English, Chinese Arabic,
French and Greek.

Language Mame: |w vl

Arabic

Chinese
French
Greek

You can also add other language for your own uses:

1. Click the button [ J- New Languiage ]_and define name for the new language:
@Ne«unguage - g

New Langusge |

Name: French

Copy From: | English -

L ) (o]

Click "OK" to save the new language in the list;
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2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, then click "Save
And Edit Next":

Language Settings
hiext Page Button # .
Last Button Last 1 Edti Language Item “ =
Previous Page Button Previous Pa e ———
Dowrload Button Downkaag || FAtLanguage Sting |
Print Button Print
Search Button search label:  FrstBution
Baook Mark Button Book Mark
Help Button Help |absied:  Presmére]
Enable Fulscreen Buttan  Enabie Fulls
Disabée Fullsresn Button Desable Ful
L Emiomad Oy Becbbnm Sramd Om i

3. At last, you can get all Labels translated into your new language as the images shows:

Label Labled

First Button Premiére

Mext Page Button Page suivante
Last Button Derniére

Previous Page Button Page précédente
Download Button Telécharger

Print Button Imprimer

Search Button Rechercher

Book Mark Button Réservez Mark
Help Button Ajde

Enable FullScreen Button Activer FullScreen
Disable Fullscreen Button Désactiver FullScreen
SraimA Cim B la SramAd

e Delete
You can delete unwanted language:

5 -
Or save your edited new language file as XML or TXT file: ST
34 Load...
Load language file saving before for current using: Ll 122
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V. Output Interface:

E] Output Option ﬂ

Output |

Output type

@ =html © *gp G%l © *.exe
@ :

Also Make Mobile Version Make output page-flipping eBook works on iPad, iPhone and Android mobile devices

Path
Qutput Folder: C:Wsers\Administrator\Documents ’ Browse. .. ] ’ Open
File Name: index .html
Options
HTML Title: Microsoft Word - Documentl
[CBum to CD

Writer |0:1:0,G: PLDS  DVD-ROM DH-16D55 VD15

Make it automatically play the flipbook in CD

I Cancel l [ LConvert

Output types:

1. HTML

"9 @ =html

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:
Options

HTML Title: demo

Set Keywords, Description or even Script in the below interface:
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Aﬂwn:vd Settngs g
HTML Advanced SetBrgs
HITML Meta Settngs
Title: Flip Woed Introduction
Keywords:  cormeert, woed, doc, flipbook, page-fipoing, shack, flash, template, security

Description: | Fiip word is & tool to convert Word files to nicelpage-fiopng eBook with ease,

Add Scrpts
You can put soms traddng
code such a5 Google
Analytics hare,
Need dosed coeript>tag!
[ il | Caned
2.ZIP

B ®@=z

=t

This output type is for compressing the created files into an integral ZIP package which can be sending out
as attachment directly. You can also define HTML Advanced Settings by clicking "Advanced"

E‘demu.html

I::n:uok.swf

Uncompress

3. EXE
5 @
This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

JE—
=

demao.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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— .
‘&4! Advanced Settings g
Exe Advanced Settings
Exe Window Info

Caption: Fip Word Introduction
Teon: iu_'l [ Defauit
Window Size Opton

& Mawmiped Custom Sae B {

Full Sereen

You can even output Mobile Version at the same time:
Also Make Mobile Version
After creating mobile versions, you just need to output all files online (including HTML, SWF, "files" and

"mobile" folders), then you can visit the flipbook page through your mobile browser.

Or even burn the output flipbook to CD:

[#] Burn to D

CD Writer | 0:1:0,G: PLDS  DVD-ROM DH-16D55 VD15 +

Disc title: Page-Flipping eBook

[¥] Make it automatically play the flipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define "Disc title", at last

C t
click button to output flipbook in your defined type.

At Last
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With Office to Flash Converter Pro, you can easy create beautiful and professional
page-flipping eBooks within a few seconds.

Now, use the wonderful to produce your style stunning page-flipping eBooks.

For more information: http://www.pdf-to-flash-converter.com /
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